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Overview

Getting touchy performance with your screen's touch screen? Resistive touch screens
are incredibly popular as overlays to TFT and LCD displays. If you want to connect
one to a computer you need something to handle the analog to digital conversion.
Most converters we've found are not very easy to use, and are 'fixed' - making them
difficult to calibrate.

The AR1100 is a nice chip that solves this problem by acting as a touch->USB
converter and also comes with calibration software. The calibration software is
Windows only, but once you've calibrated you can use the screen on any OS. The
AR1100 shows up as a regular Mouse or Digitizer HID device so no drivers are
required and it works on any operating system that supports a USB mouse (that is,
every single one we've ever seen) There is also a red LED that lights up to indicate
when a touch has been detected.
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We have a breakout that features the AR1100, which has both USB and UART
interfaces available. 99% of the time, you'll want to use the USB interface but there is
some functionality for getting TTL UART data out (see the datasheet for details)

For the screens that have 1mm pitch FPC cables, you can plug the cable right into the
connector. The majority of medium/large touchscreens have that kind of connector. If
you have another kind of touch screen, the four X/Y contacts are available on 0.1"
pitch breakouts so you can hand-solder or wire them. We set this breakout up for 4-
wire sensing only
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We also use this same chip in our TFT Touch screen designs, so that the screen can
act like a display+mouse for any kind of computer.

You can pretty much just plug and play to get started, for more details including
calibration software, check out the AR1100 page (). If you're using the breakout, plug
any Imme-pitch 4-wire resistive touchscreen to the on-board FPC connector.

Otherwise, it should already be wired up internally.

When you plug into a computer's USB port you should see a new device and touching
the screen will cause the mouse cursor to move around.

Calibrating the AR1100

If you bought a display that has the AR1100 built into it, we already did a calibration
procedure for you here in the factory, so you should be able to use it out of the box.

However, you may want to recalibrate it, say you don't think it's set up well for you, or
you want to change modes. Or you're using the breakout board and want to change
resolutions or layouts.

To calibrate the AR1100 chip, you must use a Windows computer. We know, that sucks,
but that's the only software Microchip wrote! The good news is you only have to
calibrate once, and then the calibration is stored permanently in the chip, so you do
not have to re-calibrate every time you turn it on.,
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Download and Install AR1100 Configuration

Software

Start by downloading the AR1100 Calibration/Config software here ()

and install like any other software. Now start up the AR1100 Calibration Utility software

If and only if you are using the display as a SECONDARY monitor (not your main

monitor) perform the steps below

Secondary Monitor calibration

If you have two monitors (one main one and a second with touch) you'll need to tell
the software to use the secondary monitor! To do this start up and select Exit Screen

to get out of the config screen

_ Microchip AR Configuration Utility

AR 1000 Configuration

Welcome To The AR Configuration Utility
How Do You Wish To Begin?

Configuration Wizard

K Launch the configuration wizard which will help
you set up your touch controller step by step

Start Wizard

Manual Setup Communication AR1100 USB Mouse ~ ~

§ f Configure the controller using these Sensor Type 4 Wire
O settings.

Use These Settings Calbration S-Pont

Expert

& | know what I'm doing - take me to the home
screen using the last communication method

V| Show this screen on startup

Click Options
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4@ Microchip AR Configuration
~ AR 1000 Configuration Scribble Demo Equalizer Demo P.0.S. Demo
o PKSA feSaips |0 S0 S| 1 3| calbratonInset 0 o No Touch Report ~ |Up Delay 0
(EH EEPROM K Wizard [0 11 vt 3 Enable Calibrated Coord || No Touch Report ~ State Rprt Delay 0
9 Trans Window | {{ Options|||0 2|1 +lfflo = No Touch Report ~
Tools Thresholds, Delay... | Filtering Calibration Pen Options
e Options
() Basic Opens the Options window.
(®) Diagnostic -
Transactions — = X
Commands File » Edit v > Clear (%) Report Dashboard
Read Registers
. . Y 1 1 i i 113 i
G 3:07:54 PM Welcome to the Microchip AR Configuration Utility version 2.20
3:07:54 PM  Found PICkitS.d11 - Ver: 3.1.0.2
Disable Touch
3:07:54 PM PICkit Serial Analyzer could not be found.
Save To EE i
Please check your connections.
Register Start A A A A . )
| Address 3:07:54 PM Welcome to the Microchip AR Configuration Utility version 2.20
Onerations '

Then in the options window, select the secondary type of monitor

Options
Restore Defaults Sy - B
Monitor () Primary (®) Secondary
Enter.Demo-Mode ¥ Show welcome screen
Ribbon Layout Touch Reports
oo/, -
%e,,v s, 10 3 | Touch Report Buffer Size
Tools ® O Mouse Mode (@) Defaut () Timer Based
Threshold (&) () Show cursor movement on Configuration page
FETE Y Corfiguration
Calibration () |
‘ Cal Pts (AR1100 only) Num Wires
Pen Options (e) | 94 4 Full Interpretation
. 4/5 ~
ARTID O @ . -

Communication Mode

AR1000 @ 12¢ O SPI

Select Mode then press
“Verify Communication’

Layout Preferences
Help Dock () Left
Commands Dock  (®) Left

Serial Port (AR1100 only)

() USART
AR1100 () Serial ) Mouse (

) Digttizer () HID-Generic

Verify
Communication

* Right () Foat

*) Right

Port |COM1

Then quit and restart the software, next time you run it - the program will be in the

secondary monitor

Manual Setup

Select USB Mouse as the type of AR1100 interface you want (this is the most

universall)
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Microchip AR Configuration Uti [E=EE

\
AR 1000 Configuration )

Welcome To The AR Configuration Utility
How Do You Wish To Begin?

Configuration Wizard

4.\ Launch the configuration wizard which wil help
you set up your touch controller step by step

Start Wizard

Manual Setup Communication AR1000 12

\ _J) Corfigure the controller using these Sensor Type 4 Wire
< settings.

Use These Settings Calibration 4-Point

Expert

m I know what Im doing - take me to the home
screen using the last communication method

V| Show this screen on startup

And 4-wire for the type of resistive screen

@ Mici Yehip AR Configuration Uti
AR 1000 Configuration

Welcome To The AR Configuration Utility
How Do You Wish To Begin?

Configuration Wizard

4.\ Launch the configuration wizard which will help
you set up your touch controller step by step.

Start Wizard

Manual Setup Communication AR1100 USB Mouse

Y J) Corffigure the controller using these Sensor Type m

settings.
4 Wire

5 Wire

8 Wire

Use These Settings Calibration

Expert

@ | know what I'm doing - take me to the home
screen using the last communication method

V| Show this screen on startup

|

PKSA @ Ver:220 :

And 9-point Calibration as the type of calibration (or skip calibration if you don't want
to re-calibrate)
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AR 1000 Configuration

Welcome To The AR Configuration Utility
How Do You Wish To Begin?

Configuration Wizard

%\ Launch the configuration wizard which will help
you set up your touch controller step by step

Start Wizard

Manual Setup Communication AR1100 USB Mouse

3 j Configure the controller using these Sensor Type 4 Wie
S settings
Use These Settings Calibration 4-Point.

Skip Calibration

4-point
9-Point

Expert

@ | know what I'm doing - take me to the home 25-Point
screen using the last communication method

Bxt This Screen

V| Show this screen on startup

PKSA @ Ver:220 il

You'll get some driver unloading and reloading and then the calibration screen will
pop up. Use a stylus to hit each point. There are 9 points, so if you dont end up
poking the screen 9 times, something went wrong, rerun the software to restart
calibration

Press 'Esc' to exit calibration mode

When done, you'll pop back to the 'control panel'. That's it! You can test out your
calibration with the Scribble Demo if you are using the monitor as a main screen. If its
a secondary monitor, it wont work right because the mouse shows up on the first
screen.
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AR 1100 Configuration Scribble Demo

[ EEPROM "'K Wizard 128 0 8 Calibration Inset |64 P=0,P=1 Up Delay 2
[ Trans Window {J Options | 3 8 8 Enable Calibrated Coord ||[P=1 State Rprt Delay |4
R AR1100
J Scripts 0 32 4 P=0 -
Tools Thresholds, Delay... | Filtering Calibration Pen Options
View File v Edit » X Clear (%) Report Dashboard
©) Basi 3:14:03 PM Cal: 55 02 00 14 -
() Basic
(%) Diagnostic  [3:14:03 PM Calibration touch 4 received.
3:14:04 PM Cal: 55 02 00 14
3:14:04 PM Calibration touch 5 received.
Read Registers
3:14:05 PM Cal: 55 02 00 14
Enable Touch - - .
3:14:05 PM Calibration touch 6 received.
Disable Touch | |3.14:07 pM cal: 55 02 00 14
Save ToEE  3:14:07 PM Calibration touch 7 received.
Register Stat | (3:14:09 PM Cal: 55 02 00 14
Address
3:14:09 PM Calibration touch 8 received.
Operations
3:14:10 PM Cal: 55 02 00 14 ‘j
Restore Defaults - . .
3:14:10 PM Calibration touch 9 received. J8
Te la P,

Advanced Configuration

There's a lot of settings you can adjust if you like to the AR1100. For more details,
check the datasheet but here's the stuff we find handy:

Note that if you're using a small screen, you may want to drag the window over

to the main monitor with not calibrating since the software has a lot of buttons on

the sides!

Verifying Communication

This is kind of the fix-all button if you ever find you got the AR1100 in a weird mode.
The chip can act like a mouse, digitizer or raw 'USB HID generic'. For many of the
settings adjustments you'll need to switch to HID generic since that's how the
software sends commands.
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Q/ A Configuraton | ScrbbleDemo  EqualzerDemo  P.O.S. Demo
X Wizard
Trans Window ] Options

Took: Thveshald: Fiterng Calbraton
View
Basc
OL~ 0 || ke bl A bt
Options
3:15:50 M X: 35944, Y: 35016 ®
A 3:15:50 P X: 35944, Y: 35016 Restore Defautts
Read Regsters Montor () Prmary (&) Secondsey
3:15:50 M X: 35944, Y: 35016
Enable Touch ) Enter Demo Mode ¥/ Show weicome screen
3:15:50 P X: 35944, Y: 35016
Disable Touch
3:15:50 M X: 35944, Y: 35016 Ribbon Layout Touch Repots
Sove To EE . i
3:15:50 PM X: 35944, Y: 35016 & %
e ey, 10 2 Touch Repot Bufer Sze
b rrebads 3:15:50 PM X: 35912, Y 34935
3:15:50 PM X: 35912, Y: 34935 = ° . O fine.bend
Operations et e
3:15:50 P X: 35912, Y: 34935 = > i TG
Restore Deforits -
- = 3:15:50 PM X: 35912, Y: 34935 i/ Configuration
oggje Bower Bration
Xi 35912, Y: 34935 g D Cal Pts (ART100 only) e
Verty - 5 Wres
Communications i 4 O 4Fd tepretation
Begn Calbration Found Tub.d11 - Ver: ART100 O or) %
US8 AR1100 Mouse Remol
L5y US8 AR1100 Mouse Det:

Update AR1100
Frmware

Found Tub.d11 - Ver: 1.5.0.0

AR1100 Mouse found and operating normally

ARI000 O1¢ OSPI

ARNI00 () Sedal (&) Mouse

Select Mode then press
Verfy Commurication

Layout Preferences

Serial Pt (AR1100 ony)

USART
Digizer

HID-Generc

AR1100

Yeah it would be handy if it did this for you but just bear with us and switch modes as

necessary. When you're done, dont forget to set the mode back to Mouse (or digitizer

if you wish) and Verify to set that mode

Transactions

File » Edit + > Clear () Report Dashboard
status : 121 (0x79)
debug 3 0 (0x00)

3:20:00 PM AR1100 responding and ready for operation

3:20:00 PM Touch Disable cmd sent

3:20:00 PM Sent: [55][01][13]

3:20:00 PM Received: [55][02][00][13]

3:20:00 PM Sent: [55][01][01]

3:20:00 PM Received: [55][06][00][01][01][01][42][00]
3:20:00 PM Touch Enable cmd sent

3:20:00 PM Sent: [55][01][12]

3:20:00 PM Received: [55][02][00][12]

3:20:00 PM  AR1100 - FW Ver: 1.1.66.0

3:20:12 PM  Found Tub.d11 - Ver: 1.5.0.0

3:20:13 PM USB AR1100 HID-Generic Removed . .
3:20:15 PM USB AR1100 Mouse Detected . .

3:20:18 PM Found Tub.d11 - Ver: 1.5.0.0

3:20:18 PM AR1100 Mouse found and operating normally
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Adjusting Filters and Threshholds

Depending on your setup and screen, you may find that the touch is too sensitive, not
sensitive enough, a little noisy, a little slow, etc. You can tweak just about all of the

settings in the top panel. Note that you must be in HID generic mode to do this! Then
set back to mouse when done

|
Microchip AR Configuration Utili B
A AR1100 Configuration _|_Scrbble Demo
[)Diagnostics  feSaripts | 128 SleepDelay (0 T | AcoracyFiterSow 8 . JCalbratoninset 64 . | P=0,p=1 ~ |Up Delay 2
i EEPROM W wizard | '3 T SampingFast'8 - AcawacyFiterFast 8 . || ¥ Enable Calbrated Coord | P=1 ~ State RprtDelay 4 :mmo
9 Trans Window f Options] 0 © SampingSlow 32 - SensitvityFiter 4 P=0 - g
‘ Tools Fitering Calbration Pen Options
View
Basic
) Disgnostic [ . .....
Commands
Bead Regsters Monktor O Pémary. ( Secondary ARI000 O1C OSSPl O USART
Enable Touch Enter Demo Mode V' Show weicome screen ART100 O Serial O Mouse () Digiizer (&) HIDGeneric
Disable Touch Select Mode then press Verfy
Ribbon Layout Touch Reports “Verfy Communication’ || Communication |
Save To EE
‘%3'% 10 2| Touch Repor Busfer Sze
Register Start Layout Preferences
O Mouse Mode (#) Defaut () Timer Based

« If Microchip doesn't have the download configuration software available for
some reason, we have a mirror here ()

« AR1100 product page, with datasheets, software downloads and more! ()

« Fritzing object in Adafruit Fritzing library ()

« EagleCAD PCB files for Breakout Version on GitHub ()

- EagleCAD PCB files for the TFT 50pin-to-40pin Adapter Version on GitHub ()

Breakout Version Schematic & Fabrication
Print

Here's the schematic for the breakout board, we use nearly identical setup for each
use of the AR1100
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http://www.adafruit.com/downloads/ARConfigurationUtilityV2.20.zip
http://www.microchip.com/wwwproducts/Devices.aspx?dDocName=en555168
https://github.com/adafruit/Fritzing-Library
https://github.com/adafruit/Adafruit-AR1100-Resistive-Touch-Controller-PCB
https://github.com/adafruit/Adafruit-50pin-to-40pin-TFT-with-AR1100-Adapter-PCB
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0000
- ©00 |
*adafrmt 0
AR1100@_va.2
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TFT Adapter With Touch Version Schematic
& Fab Print

="
=
i

*adafru_i; J

LCD_5@_to_48_u_Touch v.3
12/3/2014 4:55:20 PN | Sheet: 1/1
Orauing: >AUTHOR Adafruit Industries

= 50-pin to 48-pin

TIFT converter o+ &
Uith AR1100 +-uire¥ +
resistive touch- & O

scr.een contraller El

HELP!

My touch screen isn't showing up as a mouse / isn't
responding!

If your AR1100 touch screen isn't working first up

- Make sure you see the red LED blink faster when you touch the screen. If not,
check that you have a good USB cable and power
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If you get a reaction from the Red LED but its not moving the mouse cursor, its
likely your AR1100 is in non-mouse mode. The AR1100 can get set into 'Digitizer' or
'raw HID' mode, its easy to fix, run the AR1100 software and don't calibrate just go
into Expert mode if mode (or if you want to, go ahead and calibrate, doesn't matter)

@ D Vicrochip AR Configuration Ut e =TS
|

AR 1000 Configuration

Welcome To The AR Configuration Utility
How Do You Wish To Begin?

Configuration Wizard

A.\ Launch the configuration wizard which wil help
you set up your touch controller step by step.

Start Wizard

Manual Setup Communication AR1000 12C

) j Corfigure the controller using these Sensor Type 4 Wire
< settings.

Use These Settings Calibration 4-Point

Expert

@ 1 know what I'm doing - take me to the home
screen using the last communication method

Exit This Screen

V| Show this screen on startup

Then select the Options button and when the window comes up, click on the AR1100
Mouse radio button and click Verify Communications - this will force the AR1100 into

mouse

ans Window
AR1100
elays, Ser %0 Pen Opt
View
Basc
> Dot File + Edit = X Clesr ) Report Dashbope-
- Options x
~ 3:15:50 PM
o— Satip Commurication Mode
Fead Regis 3:15:50 P 4 ] Restore Defauit - -
Re ers loritor () Prmary (#) Secondary AR000 > o
T 3:15:50 PM X: 35944, Y: 35016 ) s AR1000 RC Gl Le5w
== = P welcome screen ARN00 ©) Serisl (&) Mous izec () HIDGenedc
3:15:50 PM X: 35944, Y: 35016 1L ASLE AL
Dsable Touch S Verdy
3:15:50 PM X: 35944, Y: 35016 Ribbon Layoet Touch Fapads ff:‘}?wf"*:;g' e
- Verty Comun ommuncati
fineniiafh 3:15:50 PM X: 35944, Y: 35016 1,“:’%’« Y
Regater 0 . Touch Repot fer Size fen ‘ommunication
S ekt 3:15:50 M X: 35912, Y: 34935 Layout Preforences ety < =
- Took . Mouse M . Timer Base
3:15:50 PM  X: 35912, Y: 34935 oo e Node) © Debek Bemed Help Dock () Lek Ayl
Operations T g Theshold (@ Show cursor movemert on Configuration page
Restore Defarts o - Commands Dock (&) Left Rl
3:15:50 PM X: 35912, Y: 34935 —) * Configuration
Toggie Bower
3:15:50 P X v: Cal Pis A
= Cal Pts (ART100 oniy) Num Wres )
Communicatins O 4 O 4Ful tepeetaton SENELR IR
Begn Cakwaton $17:23 M - Ver: & Ok ] b3
:17:24 P USB AR1100 Mouse Remol
AR1100
:17:26 PM  USB AR1100 Mouse Detef

:17:29 PM  Found Tub.d11 - Ver: 1.5.0.0

:17:29 P AR1100 Mouse found and operating norsally

ARUO © Ver220. ]
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I'd like to use this touchscreen with Kodi but its not
calibrated right

Check out this fine tutorial for more details on how to use the AR1100 with XBMC
Kodi

http://arendwierks.blogspot.nl/p/touchscreen-fix-raspberry-pi-xbmc-kodi.html

How can | calibrate in Linux?
Try this project!

https://github.com/tom-2015/rpi-AR1100 ()
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